


 

GoLive CyberStudio 

 

Version 3.1 Addendum

 

© 1998 GoLive Systems, Inc. All rights reserved.



 

GoLive Systems, Inc.
525 Middlefield Road, Suite 100
Menlo Park, CA 94025

1-800-554-6638

http://www.golive.com

office@golive.com

Copyright 1998 by GoLive Systems, Inc.
All rights reserved.

July 1998

The present GoLive CyberStudio® manual was designed, written and edited using the FrameMaker desktop 
publishing package running on an Apple® Macintosh® computer, printouts for proofreading and publica-
tion were made using Apple LaserWriter printers. The artwork was designed using FrameMaker, Adobe 
Photoshop® and Grafikkonverter. Postscript™, the LaserWriter page description language, is a trademark 
of Adobe Systems Inc. The typeface used throughout this manual is Ocean Sans MM by Adobe Systems Inc. 



      

....... 9

    
Table of Contents

New Features in GoLive CyberStudio 3.1
What’s New, What’s Hot?......................................................................................................3

New Authoring Features ........................................................................................................................... 3
MacOS Integration..................................................................................................................................... 4
Site Window Enhancements ..................................................................................................................... 4

Where to Look for New Authoring Tools.................................................................................5
Fontsets...................................................................................................................................................... 5
The JavaScript Editor and JavaScript Inspector ........................................................................................ 7

The Script Tab of the JavaScript Inspector.......................................................................................... 8
The Events Tab of the JavaScript Inspector ........................................................................................ 8
The Objects Tab of the JavaScript Inspector....................................................................................... 9

Using Text Macros with Source Code Editors............................................................................
Inserting Text Macros into the Source Code..................................................................................... 10
Defining Text Macros......................................................................................................................... 10
Using Delimiters ................................................................................................................................ 11
Automating Insertion Point Placement and Text Selection............................................................. 12
Calling a Macro from within a Macro ............................................................................................... 12
Using Keywords as Substitutes for Control Characters..................................................................... 13
Inserting Comments .......................................................................................................................... 14

New DHTML Feature ............................................................................................................................... 14
New Actions ....................................................................................................................................... 14
New Actions in the Image Submenu ................................................................................................ 14
New Actions in the Multimedia Submenu ....................................................................................... 15
New Actions in the Others Submenu................................................................................................ 15
New Actions in the Specials Submenu ............................................................................................. 16
Platform-Specific Browser Switching ................................................................................................ 16

Enhancements to the Web Database ..................................................................................................... 17
Improved MacOS Integration .............................................................................................. 18

QuickTime™ 3.0....................................................................................................................................... 18
Double-clicking for QuickTime™ Movie Playback ............................................................................ 18
Using HREF Tracks in QuickTime™ Movies ....................................................................................... 18
Using QuickTime™ Visual Effects ...................................................................................................... 19

Color Sync™ 2.5 Compatibility ................................................................................................................ 20
Contextual Menus.................................................................................................................................... 22
Themes-Savvy Windows .......................................................................................................................... 23
MacOS 8.5 Navigation Services ............................................................................................................... 23

New Site Management and Viewing Features ....................................................................... 24



 

vi

 

Table of Contents

 

The Site Window: More Finder-Style Than Ever ..................................................................................... 24
URL, Color, and Font Usage Inspection.................................................................................................. 26
New Publish Statuses .............................................................................................................................. 26
New Commands for Importing and Creating a Site............................................................................... 26
Multiple E-Mail Addresses....................................................................................................................... 27
New Site Viewing Features...................................................................................................................... 27

Finding Files in the Site View............................................................................................................ 27
Item Counter in the Site Navigator................................................................................................... 28
Stacked Icons in the Site Tree ........................................................................................................... 28
Changing File Access Privileges on FTP Servers ................................................................................ 28



   
License Agreement 
for GoLive 
CyberStudio

Notice—Read this before using the software!

This is a legal contract between you and GoLive Systems, Inc. 
(“GoLive”).

BY OPENING THE MEDIA ENVELOPE YOU ARE AGREEING TO BE 
BOUND BY ALL THE TERMS AND CONDITIONS OF THIS AGREEMENT. 
If you do not agree to all of the terms of this Agreement, do not use 
the Software and return the media envelope, UNOPENED, along with 
the rest of the package, to GoLive or the location where you obtained 
it.

1. Subject to payment of applicable license fees, GoLive hereby 
grants to you a non-exclusive license to use this version of its accom-
panying software product (the "Software") and accompanying docu-
mentation on the terms below. The Software may be used con-
currently by no more than the number of users specified in GoLive's 
sales invoice to you; and may be copied for archival purposes, pro-
vided any copy must contain all of the original Software's proprietary 
notices.

2. GoLive makes no representations concerning the suitability for any 
purpose of the Software or about the accuracy of data or information 
made accessible by it. The Software is provided “as is” without ex-
press or implied warranties, including but not limited to implied 
warranties of merchantability and fitness for a particular purpose or 
non-infringement of intellectual property rights of third persons. 
GoLive assumes no liability for any damages (whether direct, inci-
dental, or consequential) suffered by you or any third person as a re-
sult of use of the Software. SOME STATES DO NOT ALLOW EXCLUSIONS 
OF AN IMPLIED WARRANTY, SO THIS DISCLAIMER MAY NOT APPLY TO 
YOU AND YOU MAY HAVE OTHER LEGAL RIGHTS THAT VARY FROM 
STATE TO STATE OR BY JURISDICTION.

LIMITATION OF LIABILITY: UNDER NO CIRCUMSTANCES AND UNDER 
NO LEGAL THEORY, TORT, CONTRACT, OR OTHERWISE, SHALL GOLIVE 
OR ITS SUPPLIERS OR RESELLERS BE LIABLE TO YOU OR ANY OTHER 
PERSON FOR ANY INDIRECT, SPECIAL, INCIDENTAL, OR CONSEQUEN-
TIAL DAMAGES OF ANY CHARACTER INCLUDING, WITHOUT LIMITA-
TION, DAMAGES FOR LOSS OF GOODWILL, WORK STOPPAGE, 
COMPUTER FAILURE OR MALFUNCTION, OR ANY AND ALL OTHER 
COMMERCIAL DAMAGES OR LOSSES. IN NO EVENT WILL GOLIVE BE LI-
ABLE FOR ANY DAMAGES IN EXCESS OF GOLIVE’S LIST PRICE FOR A LI-
CENSE TO THE SOFTWARE, EVEN IF GOLIVE SHALL HAVE BEEN 
INFORMED OF THE POSSIBILITY OF SUCH DAMAGES, OR FOR ANY 
CLAIM BY ANY OTHER PARTY. THIS LIMITATION OF LIABILITY SHALL 
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NOT APPLY TO LIABILITY FOR DEATH OR PERSONAL INJURY TO THE 
EXTENT APPLICABLE LAW PROHIBITS SUCH LIMITATION. FURTHER-
MORE, SOME STATES DO NOT ALLOW THE EXCLUSION OR LIMITATION 
OF INCIDENTAL OR CONSEQUENTIAL DAMAGES, SO THIS LIMITATION 
AND EXCLUSION MAY NOT APPLY TO YOU.

3. GoLive has no obligation to issue any updates, revisions, correc-
tions, new versions, or manuals for the Software or otherwise to sup-
port the Software.

4. Content accessed through the Software is the property of the ap-
plicable content owner and may be protected by applicable copy-
right or other intellectual property laws. This License Agreement 
conveys no rights to such content.

5. GoLive reserves the right at any time to alter prices, features, spec-
ifications, capabilities, functions, licensing terms, release dates, gen-
eral availability, or other characteristics of the Software.

6. The Software is owned by GoLive or its suppliers. Title, ownership 
rights, and intellectual property rights in and to the Software shall re-
main in GoLive and/or its suppliers. You agree to abide by the copy-
right law and all other applicable laws of the United States and other 
applicable jurisdictions. You acknowledge that the Software in 
source-code form remains a confidential trade secret of GoLive and/
or its suppliers. You may not: permit unlicensed persons to use your 
copy of the Software; modify, translate, reverse engineer, decompile, 
disassemble (except to the extent applicable laws specifically pro-
hibit such restriction), or create derivative works based on the Soft-
ware; copy the Software; rent or lease rights to the Software; or 
remove any proprietary notices or labels on the Software. 

7. You may terminate this License Agreement at any time by destroy-
ing or erasing your copy of the Software. Your license will terminate 
automatically if you fail to comply with the limitations specified 
herein. Upon termination of this License Agreement, you agree to 
destroy or erase the Software. In the event of termination, the provi-
sions of paragraphs 2 to 6 of this License Agreement will survive.

8. This License Agreement shall be governed by the laws of the State 
of California, U.S.A., and the applicable local law of such jurisdiction 
where GoLive’s intellectual property rights may be infringed. The 
venue of any dispute under this License Agreement shall be the ap-
plicable State and/or Federal courts for Menlo Park, California; ex-
cept that GoLive may enforce its intellectual property rights before 
the competent courts of any jurisdiction where an act of infringe-
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ment has occurred. Final decisions of the specified courts may be en-
forced in any court of competent jurisdiction.

9. If any provision of this License Agreement is unenforceable, in-
valid, or violates applicable law, such provision shall be deemed 
stricken and shall not affect the enforceability of any other provision 
of this License Agreement.

10. This License Agreement sets forth the entire agreement between 
you and GoLive. No change, modification, addition, or amendment 
to this License Agreement shall be valid unless in writing and signed 
by an authorized officer of the party to be charged.

11. U.S. Government Restricted Rights: use, duplication, or disclosure 
by the Government is subject to restrictions set forth in subpara-
graphs (a) through (d) of the Commercial Computer-Restricted Rights 
clause at FAR 52.227-19 when applicable, or in subparagraph (c)(1)(ii) 
of the Rights in Technical Data and Computer Software clause at 
DFARS 252.227-7013, and in similar clauses in the NASA FAR Supple-
ment. Contractor/manufacturer is GoLive Systems, Inc., 525 Middle-
field Road, Suite 100, Menlo Park, CA 94025. 

Trademark 
Acknowledgments

Apple, Macintosh, LaserWriter, WebObjects, AppleScript, Power Macin-
tosh, Mac, QuickTime, WorldScript, Apple Guide, CyberDog, QuickTi-
meVR, HotSauce, Japanese Language Kit, and WebScript are 
trademarks or registered trademarks of Apple Computer, Inc. 

Microsoft Internet Explorer  is a registered trademark and ActiveX is a 
trademark of Microsoft Corporation.

Netscape, Netscape Navigator, and JavaScript are trademarks or reg-
istered trademarks of Netscape Communications Corporation.

Java, Java Applet, and HotJava are registered trademarks of Sun Mi-
crosystems Inc. 

Graphic Interchange Format  is  copyright-protected property of Com-
puServe Incorporated.

Adobe Photoshop is a registered trademark of Adobe Systems Incorpo-
rated.

International ProofReader© Dutch text proofing software © 1995 by 
Inso Corporation.  All rights reserved.  Reproduction or disassembly 
of embodied algorithms or database prohibited. 

International ProofReader© English text proofing software © 1995 
by Inso Corporation.  All rights reserved.  Reproduction or disassem-
bly of embodied algorithms or database prohibited.
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International ProofReader© French text proofing software © 1995 by 
Inso Corporation.  All rights reserved.  Spelling database adapted 
from word list supplied by Librairie Larousse.  Reproduction or disas-
sembly of embodied algorithms or database prohibited.

International ProofReader© German text proofing software © 1995 
by Inso Corporation.  All rights reserved.  Spelling database adapted 
from word list supplied by Langenscheidt K.G. Reproduction or disas-
sembly of embodied algorithms or database prohibited.

International ProofReader© Italian text proofing software © 1995 by 
Inso Corporation.  All rights reserved.  Spelling database adapted 
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International ProofReader© Portuguese text proofing software © 
1995 by Inso Corporation.  All rights reserved.  Portions adapted from 
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base prohibited.
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from word list supplied by Librairie Larousse.  Reproduction or disas-
sembly of embodied algorithms or database prohibited.

All other trademarks, registered trademarks, service names, product, 
and/or brand names referred to in this manual are the sole property 
of their respective owners.



                  
New Features in 
GoLive CyberStudio 3.1

Welcome to GoLive CyberStudio, Golive Systems, Inc.’s 
premium application for HTML layout, design, and Web 
site management. This manual addendum introduces 
you to the most prominent new features introduced with 
the new release 3.1.

What’s New, 
What’s Hot?

Golive Systems Inc.’s research & development team has gone out of 
their way to roll out a new release that is not only more stable and 
has even more useful features, but also anticipates cutting-edge 
technologies that will be incorporated in MacOS 8.5, Apple Com-
puter Inc.’s new operating system due to be released in fall 1998.

Program enhancements fall in three major categories:

• new authoring features
• MacOS integration
• Site Window enhancements 

The following sections provide listings of the new features, sorted by 
category and accompanied by brief descriptions.

New Authoring Features Here is a short list of general authoring features that have been en-
hanced:

• Fontsets are now available in the Edit menu, including applica-
tion-wide and project-specific fontsets.

• You can now double-click images or other resource files in the 
document window to open them within a suitable application, 
depending on the settings made in the preferences.

• The JavaScript Editor window has been redesigned for maximum 
ease of use.

• Users can now insert user-editable text macros in the HTML 
Source, JavaScript and WebObjects Declaration editors.

• New actions have been added to the Dynamic HTML editing 
environment. As of Release 3.1, all actions are arranged in hier-
archical submenus. 
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• GoLive CyberStudio’s Web Database now allows using default 
values for HTML attributes, gives users the option of having tags 
and characters listed either hierarchically or non-hierarchically, 
and supports “dirty” HTML, as well drag & drop. 

MacOS Integration Here is a short list of recent and future MacOS features that have 
been integrated into GoLive CyberStudio:

• GoLive CyberStudio 3.1 supports some of the upcoming Quick-
Time™ 3.0 features, including movies with embedded URLs and 
QuickTime™ Video Effects.

• Support has also been added for Color Sync™ 2.5, Apple Com-
puter Inc’s premier color matching technology. GoLive 
CyberStudio 3.1 displays JPEG images in true colors, based on 
external or embedded color profiles.

• Control-clicking text or an object in a document window brings 
up a contextual menu with the appropriate set of commands. 
Contextual menus are also supported for items in the Site Win-
dow.

• GoLive CyberStudio 3.1 has full support for the future MacOS 8.5 
Appearance Manager built-in. It is one-hundred percent Themes-
savvy, thus ensuring a smooth migration to Apple’s new operat-
ing system.

• GoLive CyberStudio is prepared to interwork with the upcoming 
MacOS 8.5 Navigation Services—a new function designed to 
ease navigation in Open and Save dialogs.

Site Window 
Enhancements 

GoLive CyberStudio 3.1 comes with further enhanced site manage-
ment and viewing capabilities. Here is a list of new Site Window fea-
tures:

• The Import Site from FTP command lets the user download a 
Web site accessible on an FTP server to a local folder.

• Users can now drag & drop a local folder from the Finder on to 
the Import Site Folder dialog.

• File access privileges can now be changed remotely on FTP serv-
ers.

• GoLive CyberStudio 3.1 supports multiple mail addresses, that is 
“Mail to” items addressing more than one receiver.

• For URLs, E-mail addresses, colors, and fontsets selected in the 
Site Window, GoLive CyberStudio shows the files they are used in.
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• Integration with the Finder has been further improved, allowing 
files to be duplicated directly in the Site Window.

• The Publish item in the File Inspector may assume any of three 
states now.

• The Find in Site command finds files in the Site View now.
• In the Site View, collapsed branches of the site tree are displayed 

as stacked items.
• The Site Navigator shows an item count.

Where to Look for 
New Authoring Tools

The following sections tells you where to look for the new authoring 
features added to GoLive CyberStudio 3.1 and instructs you how to 
use them.

Fontsets The Font command from the Edit menu lists all fontsets available for 
the current session. The choice of fontsets varies with the availability 
of their source windows: Global fontsets are displayed by default, 
while fontsets used in individual pages or stored in the Site Window 
appear only when their parent windows are open. The following 
menu shot illustrates the choice of fontsets that is available when a 
Web page and the Site Window are open.

Separators divide the Font submenu in three sections:

• The Edit Font Sets… command opens the Font Set Editor shown 
below.

• Listed below the first separator are the global fontsets managed 
by the application and the fontsets from open pages.

Fontsets in the Style Menu

Choosing Font from the Style menu…

…displays a list of fontsets available for the current 
session.

} Global fontsets and fontsets from 
open pages appear in this section.

Fontsets from open Site Windows 
appear below the separator.}
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• Listed below the second separator are the fontsets from open 
Site Windows.

The Font Set Editor dialog box lets you add and edit both global and 
page-specific fontsets. (To edit site fontsets, go to the Site Window.) 
Before creating a new fontset, you tell GoLive CyberStudio where to 
store a fontset by clicking the Default or Page icon in the left pane of 
the dialog box. The screenshot below shows the Font Set Editor dialog 
box opened by the Edit Font Sets… command. 

To add fontsets, proceed as follows:

1 Click the Default icon in the leftmost pane of the dialog box to 
add global fontsets or the Page icon to add fontsets to the page 
only.

2 Click the New button below the Font Sets list to add a new unti-
tled fontset to the list.

3 Go to the rightmost pane and click the New button below the 
Font Names list.

4 Choose a font from the popup menu below the Font Names list. 
The font name appears in the text box. In the Font Sets list, the 
new fontset is renamed according to your selection.

5 Repeat steps 3 and 4 to add more fonts to the font set until you 
are satisfied with the selection.

To edit fontsets, proceed as follows:

1 Click the Default icon in the leftmost pane of the dialog box to 
edit global fontsets or the Page icon to edit page-specific fontsets.

2 Click to select the desired item in the Font Sets list. 

The New Fontset Editor

Click this icon to ádd new fontsets to the page or 
edit existing fontsets.

Click this icon to ádd new or edit existing global 
fontsets.
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3 Go to the rightmost pane and click to select the desired item from 
the Font Names list.

4 Choose a new font from the popup menu below the Font Names 
list. The font name appears in the text box. If you have selected 
the first font in a fontset, the fontset is renamed accordingly in 
the Font Sets list.

The JavaScript Editor and 
JavaScript Inspector

The JavaScript Editor in GoLive CyberStudio3.1 has undergone a gen-
eral redesign. The Scripts, Functions, Events, and Objects fields as well 
as the Event text box have been shifted to the JavaScript Inspector, 
which has two extra tabs now. 

The following sections outline where those features can be found in 
the newly designed JavaScript Inspector.

The JavaScript Editor

The editor text box lets you edit script elements.

These buttons provide convenient shortcuts for 
display control and syntax checking.
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The Script Tab of the JavaScript Inspector

The Script tab of the JavaScript Inspector has many features in com-
mon with the Body Script and Head Script Inspectors known from pre-
vious versions. This is the location where you name scripts, select a 
JavaScript dialect and reference an external JavaScript file.

The Functions list box at the bottom of the Inspector window is one 
of the features carried over from the previous JavaScript Editor. It lists 
the functions declared in the current page. Clicking a function high-
lights it for editing in the JavaScript Editor window.

The Events Tab of the JavaScript Inspector

The Events tab of the JavaScript Inspector has assumed the role of the 
Events field and Event text box from the previous JavaScript Editor. It 
lists the objects that can have events attached and the events they 
support.

The Script Tab of the JavaScript Inspector

This option lets you select function declarations in 
the JavaScript Editor.

The Events Tab of the JavaScript Inspector

This list shows the objects and the events they 
support.
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The Objects Tab of the JavaScript Inspector

The Objects tab of the JavaScript Inspector replaces the Objects field 
previously contained in the JavaScript Editor. It holds a complete in-
ventory of JavaScript objects and methods currently defined in the 
document

Using Text Macros with 
Source Code Editors

Text macros are a power tool designed for frequent users of the 
HTML, JavaScript, and WebObjects source code editors built into 
GoLive CyberStudio. They let Web authors automate source code in-
sertion, doing away with the need to type (or copy and paste) lengthy 
strings of source code for often-used tags and script elements.

Text macros are stored in four user-editable files, which reside in a 
special Text Macros subfolder within the Modules folder in the GoLive 
CyberStudio program folder:

• The Default.macro file can hold any combination of HTML tags, 
JavaScript strings, and WebObjects code snippets. These objects 
can be inserted into any of GoLive CyberStudio’s editor windows. 
This file is GoLive CyberStudio’s default repository for text mac-
ros.

If desired, the user can create three extra files to hold environment-
specific text macros for GoLive CyberStudio’s various source code ed-
itors:

• The HMTL Source.macro file holds HTML tags only. These tags 
can be inserted into the HTML source code displayed in the 
Source tab of GoLive CyberStudio’s document window.

• The JavaScript Source.macro file holds user-defined strings of 
JavaScript code. These tags can be inserted into the JavaScript 
source code displayed in the Javascript Editor.

The Objects Tab of the JavaScript 
Inspector

This list shows the JavaScript objects and methods.
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• The WebObjects Source.macro file holds snippets of WebObjects 
code. These code snippets can be inserted into the WebObjects 
source code displayed in the WebObjects Declaration Editor.

All text macro files are loaded when GoLive CyberStudio starts up to 
make them available throughout the application. The HMTL 
Source.macro, JavaScript Source.macro, and WebObjects Source.macro 
files, however, are only loaded if the appropriate program modules 
are enabled in the Modules Manager.

Inserting Text Macros into the Source Code

Automated source code insertion is accomplished by typing the 
macro name and pressing the keyboard shortcut Command-M (or 
choosing Use Macro from the Special menu). This inserts the text 
macro identified by the word behind or below the text cursor, pro-
vided it exists in the default source macro file or source macro file for 
the editor you are currently using. 

Text macros are case-insensitive, which means that you can enter 
their names in lowercase or uppercase characters, or any combina-
tion of lowercase and uppercase, if desired.

Defining Text Macros

You define text macros by opening the desired source macro file with 
GoLive CyberStudio or a text editor and typing or copying and pasting 
the approriate code. Text macro definitions must have the following 
basic format:

MacroName [Delimiter]MacroContent[Delimiter]

The first element in a macro definition is the macro name you enter 
in the respective editor before pressing Command-M. With the ex-
ception of spaces and tabs, you can use any combination of charac-
ters for a macro name, but you should restrict yourself to using 
letters and digits. The three source code editors differ in what they 
regard as self-contained words. For example, using a dollar sign (“$”) 
in a macro name might work without any problems in the HTML 
Source Editor but will likely fail in the Javascript Editor because this 
character is an integral part of the JavaScript syntax.

Separated by a space character, the second element specifies the 
content of the macro, that is, the text that is actually inserted after 
you type the macro name and press Command-M. The content ele-
ment must be enclosed in two identical delimiter characters. When 
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you prompt GoLive CyberStudio to insert a text macro, the macro in-
terpreter will regard the first character after the separating 
whitespace as the delimiter and look for an identical character to de-
termine where the content ends. 

For example, an image tag macro with basic attributes could look 
like this:

image «<img "src=../GIFS/???.GIF" width="20" height="20">»

You can also use a text macro to insert a string of formatted text. 
Here is an example:

cyberstudio $This Web Site was designed using <B>GoLive 
CyberStudio.</B>$

Using Delimiters

As already indicated in the preceding section, delimiters tell GoLive 
CyberStudio’s text macro interpreter where the content of a text 
macro starts and ends. You can use any character as a delimiter, as 
long as you heed one basic rule: The delimiter may not occur in the 
macro content itself. You can even use whitespace and carriage re-
turns to insert structured text and multi-line code, respectively. 

Let us resume the “image” example from the preceding section to il-
lustrate the proper usage of delimiters. The macro content is en-
closed in left and right angle quotes, which are neither used in HTML 
nor JavaScript nor WebObjects source code.

Here is an example of improper delimiter usage:

image "<img "src=../GIFS/???.GIF" width="20" 
height="20">"

This macro definition won’t produce a usable result because it uses 
double quotes as delimiters. The double quotes are already used to 
enclose tag attributes in the HMTL tag definition, so GoLive CyberStu-
dio will only insert the text before the second double quote charac-
ter. The result would be an incomplete tag:

image "<img 

As a general rule of thumb, you should refrain from using char-
acters that are typically used as structural elements within the 
source code syntax, for example the "less than" (<) and "great-
er than" signs (>) enclosing HTML tags.
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Automating Insertion Point Placement and Text Selection

Normally, when inserting a text macro, GoLive CyberStudio’s text 
macro tool selects the entire insert. To ensure a smoother workflow, 
however, you can also place the insertion point or select text for over-
typing anywhere in the insert. 

Placing the insertion point in an insert is accomplished by adding a 
“vertical bar” character (“|”). Here is an example:

image «<img "src=|" width="20" height="20">"»

The vertical bar after the src attribute and “equal to” sign places the 
insertion point so you can enter the attribute value without having 
to move the cursor to the desired location.

Selecting text for overtyping is accomplished by enclosing a place-
holder word or string in single quotes (“'”). Here is an example:

image «<img "src=../GIFS/'???'.GIF" width="20" 
height="20">"»

The three question marks enclosed in quotes will be selected when 
you insert this example macro, allowing them to be overtyped with 
a filename.

Calling a Macro from within a Macro

To reduce overall typing work and make your macro files easier to 
maintain, GoLive CyberStudio’s text macro tool lets you reference 
other macros from within a macro. 

To call another macro from within a macro, you need to enclose the 
name of that macro in dollar signs (“$”). The following example 
shows the proper syntax:

Macro #1:

meta-author «<META NAME="author" CONTENT="$author$"»

Macro #2:

author "Michael Daeumling"

Upon insertion of the meta-author macro, GoLive CyberStudio will 
automatically look for the second macro named “author” and insert 
its content at the specified location in the first macro, so the resulting 
text insert would read:

meta-author <META NAME="author" CONTENT=" Michael 
Daeumling"
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If calling a second macro produces uneexpected results, this may be 
due to a circular reference. Circular references occur if the second 
macro contains a reference back to the macro called in the first 
place. The text macro tool handles those circular references grace-
fully without entering an endless loop. Rather than that, it will sup-
press the circular reference and insert the macro name found at the 
beginning of the macro definition.

Here is a simple example:

A "A to $B$"
B "B to $C$"
C "B to $A$"

The resulting text insert would read:

A to B to C

As can be seen from the above example, GoLive CyberStudio ignores 
the circular reference pointing back to macro “A” and inserts the 
macro name “C” instead.

Using Keywords as Substitutes for Control Characters

As outlined in the preceding sections, you can use three control char-
acters to specify what happens when a text macro is inserted:

• Single quotes (“'”) mark out a selection.
• The vertical bar places the insertion point.
• Dollar signs are used to reference another text macro.

Now and then, syntax rules may require that you insert a macro with 
any of those characters in it. For example, JavaScript syntax requires 
that text strings be enclosed in single quotes. This conflict is solved 
by substituting percent signs (or any other suitable character) for sin-
gle quotes. GoLive CyberStudio’s text macro tool has three built-in 
keywords that allow you to redefine control characters:

• SELECTION lets you redefine the selection markers if single 
quotes are not permitted. Here is an example:
Selection = %
write.document.write('%what%')

• CARET lets you redefine the insertion point marker if the vertical 
bar is not permitted—for example because it is used to express 
a bitwise OR operation in JavaScript.
CARET = %
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• MACRO lets you redefine the dollar signs enclosing a macro 
name. 
MACRO = %

Inserting Comments

You can insert comments to inform other users about the function 
of a particular macro. Comments must be preceded by a semicolon 
character. Here is anexample:

;This macro inserts a JavaScript that verifies form 
input.

New DHTML Feature New Actions

With GoLive CyberStudio 3.1, a wide choice of actions is now avail-
able for Dynamic HTML authoring. The Actions menu in the Action 
Inspector has hierarchical submenus to make actions easier to locate. 
Also, the Action Inspector displays browser compatibility information 
for any action you select from its Actions menu. The following screen-
shot shows the new appearance of the Action Inspector.

The following section contains brief descriptions of the new actions 
in the Image, Multimedia, Others, and Specials submenus.

New Actions in the Image Submenu

Two new actions are available in this submenu:

• Preload Image forces the browser to cache the images used in a 
mouse rollover. Although the page takes longer to load up front, 
this script improves the responsiveness of the animation 

Browsing the Hierarchical Actions Menu 
in the Action Inspector

The Actions Menu is hierarchical now. Six catego-
ries make actions easier to locate.

Browser compatibility information is dis-
played for any action you select from the 
Actions menu.
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because it avoids loading the alternative image when the visitor 
clicks the animated button. This script should be assigned to an 
action item in the header section.

• Random Image swaps the content of an image at random upon 
receipt of an external trigger, such as a mouse-click by the visi-
tor. You can specify one base image plus up to three alternative 
images.

New Actions in the Multimedia Submenu

There is only one new action in this submenu:

• Wipe Transition “wipes in” or ”wipes out” the content of a float-
ing box. The user can specify the direction of the wiping move-
ment. Wiping options include: 
- left-to-right

- right-to-left

- top-to-bottom

- bottom-to-top

- center-to-outline (wipe in only)

- outline-to-center (wipe out only)

New Actions in the Others Submenu

There are seven new actions in this submenu:

• Navigate History uses the browser’s history records of URLs vis-
ited in a session to go back or forth by a user-specified number 
of windows.

• Netscape CSS Fix is a workaround script for a bug in several ver-
sions of Netscape Navigator 4 that makes a page lose its DHTML 
content when the window is resized.

• Go Last Page returns the browser to the last URL visited in a ses-
sion.

• Resize Window dynamically changes the browser window to a 
user-specified size.

• Scroll Down, Scroll Left, Scroll Right, and Scroll Up scroll the 
browser window by a user-defined amount of pixels and at a 
user-defined speed.
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New Actions in the Specials Submenu

There are five new actions in this submenu:

• Condition inserts a script that, upon receiving a trigger (such as a 
mouse-click by the visitor or a certain point on the timeline of 
the animation), checks whether a condition is fulfilled. The con-
dition is specified by selecting an Intersection or Timeout action 
(or any other action that returns “True” or ”False”). The output is 
either “True” or ”False”, depending on whether the condition is 
fulfilled or not. Either output can be used to trigger another 
action. 

• Action Group lets you group multiple actions to have them trig-
gered simultaneously.

• Idle inserts a script that checks, at fixed intervals, whether a con-
dition is fulfilled. The condition is specified by selecting an Inter-
section or Timeout action (or any other action that returns “True” 
or ”False”). The output is either “True” or ”False”, depending on 
whether the condition is fulfilled or not. Either output can be 
used to trigger another action. This action goes into the head 
section of the page.

• Intersection checks whether two floating boxes overlap. This is a 
companion action to the Condition and Idle actions described 
above.

• Timeout checks whether a user-specified time span (in seconds) 
has elapsed. This is a companion action to the Condition and 
Idle actions described above.

Platform-Specific Browser Switching

The Browser Switch item from the CyberObjects tab of the Palette and 
its companion Browser Switch Inspector have been redesigned to let 
you specify operating system compatibility for the Web browser. The 
following screenshot shows the new platform selection menu in the 
Browser Switch Inspector.



17Where to Look for New Authoring Tools
Enhancements to the 
Web Database

The changes made to the Web Database were driven by the need to 
make it even more user-friendly. One of the major changes is the in-
troduction of drag & drop editing, allowing the user to copy selected 
text (for example an attribute name or a comment) from one tag to 
another.

The listing of tags and characters in the Web Database window can 
be set to non-hierarchical using the new Plain option in the Web Da-
tabase Inspector. An example of a plain non-hierarchical listing is 
shown below.

A new feature introduced for HTML-savvy users is the “dirty HTML” 
option in the Global tab of the Web Database window. Activating this 
checkbox relaxes the strict rules of HTML usage, permitting HTML 
code that isn’t exactly “by the book”, such as a <FONT> tag spanning 
several paragraphs (<FONT> <P></P><P></P><P></P> 
</FONT>). 

The New Platform Selection Menu in the 
Browser Switch Inspector

This popup menu lets you specify the platform 
the current page has been designed for.

This text box lets you specify an alternative 
page.

Selecting a checkbox indicates that this brows-
er version is compatible with the current page.

A Plain Listing in the Web Database 
Window

Tags in the Web Database window are listed in a 
plain alphabetical order if you choose the Plain 
option in the Web DB Inspector.
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Improved MacOS 
Integration

The following section outlines how GoLive CyberStudio benefits from 
new MacOs features to improve its multimedia authoring capabili-
ties. Also introduced are the new ColorSync™-based color matching 
feature for JPEG images, the new support for contextual menus, as 
well as the integration of Themes and Apple Navigation Services—
two new features that ensure compatibility with upcoming MacOS 
releases.

QuickTime™ 3.0 GoLive CyberStudio opens and plays back QuickTime™ movies with a 
least one active video track. What is more, GoLive CyberStudio 3.1 is 
tightly integrated with QuickTime™ 3.0, allowing Web authors to ac-
cess cutting-edge multimedia authoring features such as HREF tracks 
and visual effects from within the application. 

Double-clicking for QuickTime™ Movie Playback

Also new to release 3.1 is the ability to open QuickTime™ movies for 
playback by double-clicking the plugin icon in the document win-
dow. This brings up the MoviePlayer window shown below.

Using HREF Tracks in QuickTime™ Movies

HREF tracks in QuickTime™ movies contain URLs the browser will 
jump to at a specified point in time during playback. GoLive 
CyberStudio 3.1 lets you load QuickTime™ movies, insert or edit 
HREF tracks, and specify destination URLs. This feature is best used 
in a page with HTML frames, where the movie plays back in one 
frame and a second frame is used to display the alternative URLs ad-
dressed during movie playback. This approach allows the movie to 
continue playing in one frame, while the content of the other frame 
is swapped—either by the visitor clicking at the movie or automati-
cally. The following screenshot shows the interaction between the 

Movie Player with QuickTime Movie
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HREF tab of the QuickTime Inspector (the tool you use to edit HREF 
tracks in QuickTime™ movies) and the Movie Player window. 

You open a QuickTime™ movie using the Open command from GoLive 
CyberStudio’s File menu, which brings up the QuickTime Inspector and 
Apple Movie Player. You can then proceed to editing the movie: For ex-
ample, you insert one or more segments on the HREF track, adjust 
their start times by clicking in the Movie Player play bar, then specify 
destination pages and a target frame in the parent frameset. 

When you are done editing the HREF track, you will be prompted to 
save the QuickTime™ movie.

Using QuickTime™ Visual Effects 

The new GoLive CyberStudio 3.1 release is so seamlessly integrated 
with QuickTime™ 3.0, it even lets you benefit from some of the tools 
shipped with Apple’s new multimedia authoring suite. GoLive 
CyberStudio lets you load QuickTime™ movies and add visual effects 
using the Effects tab of QuickTime Inspector (shown below).

Interaction between the QuickTime 
Inspector and Movie Player

This option toggles the display of the HREF track in 
the Movie Player window on and off.

This option auto-loads the content of the destina-
tion URL (instead of waiting for a mouse-click).

The segments of the HREF track are listed here.

The Replace, Add, and Delete buttons let you up-
date, add, and delete segments on the HREF track.

This text box lets you specify a destination URL—for 
example, a local page to be inserted in a frameset.

This text box lets you specify the target frame where 
the new page should appear.

Drag or click the play bar to determine 
the start time for the active segment.

The Effects Tab of the QuickTime Inspector 

The Apply button lets you add a visual effects track 
to a QuickTime™ movie.

The Delete button lets you remove a visual 
effects track from a QuickTime™ movie.

Use the Open command to open a a QuickTime™ 
movie, then click the Effects tab rider to add visual 
effects. The active filter appears here.
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Clicking the Apply button in the QuickTime Inspector brings up a sec-
ond window, titled Select Effect…, to let you choose the visual effect 
you want to have applied to the movie.

When you are done selecting the effect and making adjustments, you 
will be prompted to save the QuickTime™ movie (for example in the 
Site Window to make it available to the site you are working on).

Color Sync™ 2.5 
Compatibility

GoLive CyberStudio3.1 supports Color Sync™ 2.5, Apple Computer 
Inc.’s premier color matching technology. GoLive CyberStudio 3.1 
uses ColorSync™ ICC profiles to match the image's and monitor's 
color spaces and display JPEG images in true colors. The ICC color 
profile for an image is either embedded in the image file itself or 
comes as a a standalone ICC color profile (for example, one of the 
profiles shipped with the ColorSync™ installation package), while the 
monitor’s ICC profile is selected in the ColorSync™ control panel. 

The image's profile may be determined in one of the following ways, 
in the following order of precedence:

• embedded profile 
• profile referenced by the ICCPROFILE attribute of the IMG tag 
• profile referenced by the ICCPROFILE attribute of the BODY tag
• default color space selected in the ColorSync™ control panel

The color matching controls for individual images reside in the Link 
tab of the Image Inspector. They are active whenever you select a 
JPEG image in a document window. The following screenshot illus-
trates the new color matching controls in the Image Inspector and ex-
plains their functions. 

The Select Effects… Window 

This list contains the visual effects you can apply 
to a QuickTime™ movie.

This pane allows you to preview the effect.

Each effect has a typical set of controls.
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As of this writing, support for Web color profiles is very limited. 
The only browser that can currently handle ICC profiles is Mi-
crosoft Internet Explorer 4.01 for the Macintosh, which uses 
ColorSync™ to display embedded color profiles in JPEG images. 
Color matching support on other platforms is not yet standard-
ized, but will be implemented in future versions of GoLive 
CyberStudio as new standards emerge.

Additionally, color matching can be enabled globally for any JPEG 
image in the page using the options in the ColorSync™ tab of the Page 
Inspector. The following screenshot illustrates the new color match-
ing controls in the Page Inspector and explains their functions. 

GoLive CyberStudio’s interaction with ColorSync™ is controlled by a 
checkbox in the Preferences - ColorSync™ dialog box, which turns 

New Color Matching Options in the Link 
Tab of the Image Inspector

This option selects the default behavior specified 
by the ColorSync™ control panel. 

This option selects a standalone color profile.

This option disables color matching altogether.

This text field displays a color profile embedded in 
the JPEG image.

New Color Matching Options in the 
ColorSync™ Tab of the Page Inspector

This option selects the default behavior specified 
by the ColorSync™ control panel. 

This option selects a standalone color profile.

This option disables color matching altogether.
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color matching on and off for the entire application. The following 
screenshot illustrates the usage of this global control.

The Use Default RGB Profile if  not specified option lets GoLive 
CyberStudio use the standard RGB color profile selected in the 
ColorSync™ 2.5 control panel if images do not contain embedded 
color profiles or if you don’t assign an external profile.

Contextual Menus Control-clicking text, an image, or a plugin object in a document 
window brings up a contextual menu with the appropriate set of 
commands. Contextual menus are also supported for items in the 
Site Window. The screenshot below shows a contextual menu in the 
Site Window.

The Preferences - ColorSync Dialog Box

Click the Colorsync™ icon to set global color 
matching preferences for GoLive CyberStudio. 

This option lets GoLive CyberStudio default to the 
color profile selected in the ColorSync™ control 
panel.

This option toggles color matching on and off.

A Contextual Menu in the Site Window

Control-clicking now opens a contextual menu.
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Themes-Savvy Windows GoLive CyberStudio 3.1 has full support for the future MacOS 8.5 Ap-
pearance Manager built-in. It is one-hundred percent Themes-savvy, 
thus ensuring a smooth migration to Apple’s new operating system. 

The screenshot above shows an Inspector window customized using 
the Kaleidoscope™ control panel by Greg Landweber and Arlo Rose 
(available for downloading at http://www.kaleidoscope.net), which 
lets you anticipate many of the appearance customization options 
future MacOS versions will bring to your desktop. 

Themes support is enabled by activating the Appearance Theme 
Savvy option in the Preferences - General - Display dialog box.

MacOS 8.5 Navigation 
Services

MacOS 8.5 feature support is also provided for the upcoming 
MacOS 8.5 Navigation Services—a new function designed to ease 
navigation in Open and Save dialogs. The screenshot below gives you 
an impression of how MacOS File Open dialogs in GoLive CyberStudio 
might look in the future.

Customizing Window Appearance

A File Open Dialog Modified by 
Apple Navigation Services
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New Site 
Management and 
Viewing Features

The following section presents the functional enhancements to 
GoLive CyberStudio’s Site Window and the Site View, the built-in struc-
tural viewing and Web site design tool. 

The Site Window: More 
Finder-Style Than Ever

Although apparently unchanged, GoLive CyberStudio’s Site Window 
has been enhanced in functionality to make it even easier to use. In-
tegration with the Finder has been further improved, allowing Mac-
intosh users to manage files exactly like they would in the Finder. 

More than ever, the Files list in the Site Window now works exactly 
like any window in the Macintosh Finder:

• Selecting a file from the Files list and choosing the new Duplicate 
command from the Edit menu (or pressing Command-D) dupli-
cates the file, appending a simple numeral to the filename.

• Clicking a filename activates it for overwriting after the user-
selected double-clicking interval adjusted in the “Mouse” control 
panel.

• In previous versions, double-clicking to open a file was only sup-
ported for HTML files. GoLive CyberStudio 3.1 now lets you open 
any file with the proper filename extension in an external appli-
cation, based on file mapping preferences you adjust in the Pref-
erences - General - File Mapping dialog box shown below.

• The new Kind column displays the file type based on informa-
tion from the Preferences - General - File Mapping preferences 
dialog box (see screenshot below for instructions).

The Site Window

You can duplicate and rename files exactly like in 
the Macintosh Finder, even double-click to open 
non-HTML files.
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If the Enable file open in other applications checkbox is activated, this 
preferences dialog lets you specify what happens when you double-
click an item in the Site Window or a document window. Here are the 
scenarios GoLive CyberStudio can handle:

• File without a filename extension and with unknown creator: 
Double-clicking opens MacOS EasyOpen (if enabled), where you 
can choose an external application that should open the file. 

• File without a filename extension but known creator: Double-
clicking opens the file in its creator application. 

• File with filename extension but unknown creator: If you use the 
options in the File Mapping dialog box to specify an application 
for the filename extension, double-clicking will open the file in 
that application. 

The File Mapping Preferences give you several options: You can use 
GoLive CyberStudio’s default file mappings, import mappings speci-
fied in Internet Config, or use either set of file mappings and custom-
ize it. 

To customize file mappings, choose Custom from the File Mapping 
popup menu, then click the New button. Go to the first text box and 
enter a filename extension, continue to the popup menu to the right 
and browse for an application, then use the two remaining text 
boxes to enter the MIME type (optional, only if known) and a descrip-
tion that appears in the Kind column of the Site Window.

The Preferences - General - File Mapping 
Dialog Box

The File Mapping Preferences let you indicate the 
application that should respond when you dou-
ble-click a file in the Site Window or a GoLive 
CyberStudio document window.

The buttons below the file mappings list let you 
merge and edit file mappings.

These text boxes and the popup menu let you 
create new file mappings and assign an applica-
tion that should be used to open files with a 
matching extension.

This popup menu switches between Internet 
Config, GoLive CyberStudio default, and Custom 
file mappings. Only Custom file mappings can be 
edited.
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URL, Color, and Font 
Usage Inspection 

The Link Inspector now lets you find out where the URLs, E-mail ad-
dresses, colors, and fontsets listed in the Site Window are actually 
used. The screenshot below shows an example.

New Publish Statuses The Publish option in the File Inspector—a simple “on or off” check-
box option in previous versions—is now a three-item popup menu 
that lets you specify a condition under which a file is published. You 
use this option when exporting a site using the Export Site command 
from the Site menu. Menu items include:

• Always publishes the file unconditionally.
• Never exempts the file from publishing alltogether.
• If  referenced publishes the file only if it is referenced by a Web 

page in your site.

New Commands for 
Importing and Creating a 
Site 

The site creation commands in the File menu have been rearranged. 
They are now united in a submenu that opens when you choose the 
New Site command.

Following is a short rundown of the new menu options:

• Blank… creates a new site with a blank index.html homepage. 
This supplants the New Site command from version 3.0.Import 
Site from Folder… imports a user-selectable folder and creates a 
site document from the content of that folder. This replaces the 

Inspecting Color Usage with the 
Link Inspector

The Link Inspector displays the pages a selected 
URL, E-mail address, color, or fontset is used in.

The New Site Submenu of the File Menu

GoLive CyberStudio’s site creation commands all 
reside in the same submenu now.
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Import Site Folder… command known from version 3.0. The 
subsequent dialog box—still titled Import Site Folder…—is now 
drag & drop capable. You specifiy the folder to import by drag-
ging it from the Finder on to the site name text field in the 
Import Site Folder… dialog box.

• Import Site from FTP… lets you contact an FTP server and create 
a site off the material you download.

Multiple E-Mail Addresses GoLive CyberStudio 3.1 supports mailto: hyperlinks with multiple 
E-mail addresses—for example: 

mailto: oziv@golive.com, jkranz@golive.com

As in previous versions, mailto: items are stored in the Site Window 
for drag & drop insertion into Web pages. In release 3.1, however, 
you can have GoLive CyberStudio insert an additional mailto: text 
string before the hyperlink or disable auto-insertion in the Prefer-
ences - General - URL Handling dialog box.

New Site Viewing 
Features

The Site View displayed in the Site tab of GoLive CyberStudio’s Site Win-
dow comes with some worthwhile enhancements for everyday work. 

Finding Files in the Site View

GoLive CyberStudio 3.1 lets you find files in the Site View. If the Site 
View is in the foreground, clicking the Find Files in Site button in the 
Site Toolbar opens the Find dialog box with the Find File tab acti-
vated. After entering the filename (or a filename fragment) and click-
ing the Find button, GoLive CyberStudio highlights any file with a 
matching filename in the Site View.

The New Site from FTP Dialog Box

Use these options to specify the server and di-
rectory as well as identify yourself and enter a 
password.

This text box shows the name of the local folder 
your site will be saved to. You can pick another 
folder after clicking the Browse… button.

{ This popup menu lets you choose 
a server already specified in the 
Site Settings dialog box.
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Item Counter in the Site Navigator

The Site Navigator displays two item counts now.

The first count specifies the number of items in the visible display 
area of the Site Navigator (and the Site View), the second indicates the 
total number of items in the site, both visible and invisible.

Stacked Icons in the Site Tree

Rather than hiding the icons in collapsed parts of the site tree, the 
Site View displays them as a stack now.

Changing File Access Privileges on FTP Servers

While connected via FTP, GoLive CyberStudio lets you set some basic 
file access privileges on UNIX servers—within the limited scope per-
mitted during an FTP session. The file access privileges you change 
here are only valid for your group. 

The Site Navigator

This item counter displays the number of items in 
the visible display area of the Site Navigator and 
the total number of items in the site.

Stacked Icons in the Site View

Stacked icons indicate that the site tree has been 
collapsed.
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The FTP Inspector comes up while you are using the built-in FTP tool 
in the Site Window or the standalone FTP window. The options in the 
Rights section can only be used while you are connected to UNIX 
servers; they are not available in a session with Windows NT™-based 
or other server machines.

The FTP Inspector

Use these options to change the access rights for 
your group. {
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